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1 Origin Installation and Startup 

1.1 Introduction 

Welcome, and thank you for using Origin! In this guide, unless otherwise noted, "Origin" will 
refer to both Origin and OriginPro. 

Origin is a Windows application. You can run Origin on an Intel-based Mac if you have installed 
virtualization software and set up a virtual computer running Microsoft Windows. For more 
information, see the OriginLab website (www.originlab.com). 

There are three steps that must be completed to prepare Origin for use: 

• Installation 

• Selection of a User Files folder 

• License management 

1.2 Installing Origin 

Both the Origin upgrade and the full product install into a new program folder. Origin does not 
overwrite previous versions when upgrading, so your original version does not have to be 
installed when running the upgrade. 

The startup program that launches when you insert the Origin DVD includes an Origin 
installation button. If the startup program does not automatically run, you can browse the DVD 
to launch the startup program (or the installer). 

In addition to the script-based Origin installer that runs from the DVD startup program, an MSI 
installer is provided on the DVD. The MSI installer is ideal for use at multi-user sites, as it can 
be used to build an Origin installation package for distribution. Sample MSI transforms are 
provided on the DVD. 

For more information on multi-user site deployment, see the Support area of the OriginLab 
website. 

Installing on a 64-bit Computer 

When installing on a 64-bit computer, you have the option to install 32-bit or 64-bit Origin, or 
both. The 64-bit version has much more memory at its disposal, so it is useful for large data 
sets. However, some data import formats are only available in 32-bit Origin. See the Support 
area of the OriginLab website for more information about 32-bit versus 64-bit installations. 
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If you install 32-bit only (or 64-bit only), and you later want to install 64-bit (or 32-bit), run the 
Origin Add or Remove Files program located in the Origin program icon folder, or rerun the 
Origin installer (both require a log in account with administrator permissions). When the Origin 
setup program starts, select the Modify option. 

How to Proceed if You Already Have the Origin Evaluation 
Installed 

If you already have the evaluation version of Origin installed on your computer, you can 
convert it to the full product or upgrade. To do this, run the Origin Add or Remove Files 
program located in the Origin program icon folder, or rerun the Origin installer (both require a 
log in account with administrator permissions). When the Origin setup program starts, select 
the Modify option and then select Install Product (requires serial number). 

How to Correct or Change your Serial Number After you 
Complete an Installation 

If you installed Origin with an incorrect serial number, you can correct it by running the Origin 
Add or Remove Files program located in your Origin program icon folder, or rerun the Origin 
installer (both require a log in account with administrator permissions). When the Origin setup 
program starts, select the Modify option and then click Yes to change your serial number. 

1.3 Selecting a User Files Folder 

After installing Origin, each Windows log in user must select a User Files folder at the first 
Origin startup. The User Files folder is the default location for saving and opening files for that 
log in user. 

Consider these points in selecting your User Files folder: 

• If you have a mobile computer, it is best to select a User Files folder location on your computer 

rather than on your network. 

• For non-mobile computers, you can select a User Files folder location on the computer or the 

network, as long as you have stable access to the folder. 

• Do not select the same User Files folder as other Origin users. To learn how to share custom 

files with other Origin users, please review the Origin Help file. 

• If you upgraded from an earlier version of Origin, you must select a User Files folder different 

from your previous installation's User Files folder. To transfer files from your previous 

installation's folder, click Tools, and then click Transfer User Files. 
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At each Origin startup, Origin will check that your User Files folder is accessible. If Origin can 
not connect to the User Files folder, you must select a new folder at startup. Also, you can 
change your User Files folder when you are running Origin. From the Tools menu, click 
Options and then click the System Path tab. 

1.4 Licensing Origin 

All Origin packages include license management. The type of license management provided 
with your package is determined at the time of your Origin purchase. 

Node-locked 

Each Origin computer requires a license to run Origin. The license is obtained from the 
OriginLab website using a licensing "wizard" provided when you start Origin. This process 
requires a log in account with administrator permissions. Instructions are provided for 
computers with no internet access. 

Concurrent Network 

Each Origin computer must connect to a FLEXnet license service to run Origin. Your IT 
department or Origin administrator installs a FLEXnet license server provided by OriginLab 
(available from the Origin DVD), obtains a license for this server from the OriginLab website, 
and then sets up a license service. The license service counts and restricts the number of 
Origin computers that can run concurrently. 

For more information, see the Support area of the OriginLab website. 

Dongle 

A dongle (USB hardware key) is provided with the Origin package and must be present in the 
computer's USB port to run Origin. The dongle license is installed by Origin. 

1.5 Registering Origin 

Although registration is optional, it is recommended. Registering Origin is a prerequisite for 
Origin support from OriginLab and the team of Origin distributors. Registration also activates 
Origin's Check for Updates command (available from the Help menu). Check for Updates 
allows you to check if patches or updated Help files are available for your Origin installation, 
and to obtain those updates. 

If you have an Origin package with node-locked license management, your Origin installation is 
automatically registered when you successfully complete the licensing process. To verify this, 
click About Origin from Origin's Help menu. The About Origin dialog box will display the 
Registration ID assigned to your Origin package. 
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For all other license management packages, a Registration dialog box displays when starting a 
licensed, but unregistered, Origin installation. Use the Registration dialog box to register your 
Origin installation on the Origin website. During this process, a Registration ID is issued. Enter, 
or copy and paste, this Registration ID into the Registration dialog box to complete the 
process. The About Origin dialog box will now display your Registration ID. 

1.6 Setting the Origin Display Language 

Origin packages sold to organizations in a limited number of countries, including Japan, 
Germany, Switzerland, Austria, and Liechtenstein, may support running Origin with English 
display, or with Japanese or German display. To access this language control, click Help and 
then click Change Language. 

1.7 System Transfers - Deactivating a License 

Node-locked Licenses (Computer ID-based) 

A system transfer is required if you plan to replace your licensed Origin computer with a 
different computer. 

• If Origin can still run on your computer: 

Run Origin. Click Help and then click Deactivate License. After successful license 
deactivation, your Computer ID will be removed from the OriginLab license server so that you 
can install and activate on another computer. 

• If your licensed Origin computer is no longer available: 

Complete the "license/computer transfer" form available from the Support area of the OriginLab 
website. 

Concurrent Networks 

A system transfer is only required if you need to replace the FLEXnet license server. A system 
transfer is not required when replacing an Origin computer. 

To obtain a replacement FLEXnet server license file, complete the "license/computer transfer" 
form available from the Support area of the OriginLab website. 

Dongles 

A system transfer is not required when replacing a dongle-managed Origin computer. 
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1.8 Uninstalling Origin 

To uninstall Origin, run the Origin Add or Remove Files program located in the Origin program 
icon folder, or use the Windows Uninstall or change a program tool. In both cases, the Origin 
Setup program displays providing options to Modify, Remove, or Repair. Select the Remove 
option and complete the wizard as prompted. 

The Remove program deletes all folders and files that were installed by the Origin setup 
program. It also deletes folders and keys created by the installer in the Windows registry. 
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2 Introduction to Origin 

2.1 The Origin Project 

The Origin project file (.OPJ) combines data, notes, graphs, and analysis results in one flexibly 
structured document. All components of an Origin project can be interactively accessed when 
the project file is opened in Origin. Origin project files can also contain attachments of internally 
saved Microsoft Excel files or links to external Excel files, LabTalk script and Origin C code 
files, and third-party files. 

Combined with the ability to recalculate results on a change of input data or a change of 
analysis parameter settings, the Origin project can function as an Analysis Template for 
performing repeat analysis on multiple sets of similar data. 

The dockable Project Explorer window in the Origin Interface helps you organize and interact 
with various components of an Origin project. Components such as workbooks, matrix books, 
graph pages, and notes windows can be organized in a user-defined folder structure with the 
flexibility of adding subfolders to any desired level. 

You can open only one Origin project file (.OPJ) in a single session. You can, however, append 
multiple project files from disk, or save a folder and its subfolders to disk as a project file. You 
can also save individual windows, such as workbooks and graphs, and open them later to add 
to another project. 
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Origin's Project Explorer functions similarly to Windows Explorer. You can sort component 
windows by name, data, size, or time. Using the context menus in Project Explorer, you can 
access other options, such as displaying Long and Short names, launching a slide show of 
graphs within a folder, or appending other Origin Project files from disk. 

With a good understanding of the features of Origin’s Project Explorer, combined with the 
features of workbooks and matrix books, you can efficiently organize all your data, graphs, 
notes, and analysis results in a single project file. 
 

2.2 Hierarchy of Origin Objects 

The following sections provide basic information on the hierarchy of the workbook, matrix book, 
and graph window objects in Origin. Further details on the hierarchy of these and other objects 
can be found in the Origin Help file. 
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Workbooks 

The Origin workbook is organized as a collection of worksheets. A workbook can contain 
multiple worksheets, also known as layers, each of which has a unique name. 

A worksheet contains a collection of columns. A column can be set to one of several data 
formats, including Text & Numeric, Numeric, Text, Data, and Time. Note that a single column 
can contain only one type of data. You can format individual cells or groups of cells in a column 
by customizing such properties as font, color, or number of decimal digits to display. 

All columns have fixed properties (or metadata) displayed in label rows on top, including Short 
Name, Long Name, Units, and Comments. The values of these properties are used to 
address and represent data columns within the Origin graphical interface. These values are 
also used for annotation when graphs are created from data stored in the columns. You can 
also add custom label rows, called User Parameters, to store additional meta data. The User 
Parameter rows can be assigned arbitrary names. 

Numeric data stored in a column can be graphically displayed in the column header in a 
special label row called Sparklines. A sparkline is a small inset plot of the data in a column, 
plotted as the dependent variable (Y) against the row number as the independent variable (X). 
Origin displays sparklines by default when data is imported into the columns. You can turn 
sparklines on with the Add Sparklines< command in the Column menu or column context 
menu. 

Worksheet columns also have a Plot Designation property that includes the designations X, 
Y, Z, Y Error, and Label. This plot designation property allows you to quickly create graphs by 
selecting columns, and is also used by some Origin dialogs to automatically recognize and 
assign input data for operations such as curve fitting. 
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A Column Properties dialog is available to customize numerous column properties including 
name, plot designation, format, and subformat. Double-click or right-click the column header to 
access the Column Properties dialog. 

The Set Column Values entry in the Column menu opens a Set Values dialog which can be 
used to fill a column with values. The formula can refer to other columns in the same sheet, 
and can utilize various mathematical, statistical, and other functions available from the F(x) 
menu in the dialog. The Before Formula Script panel at the bottom of the dialog can be 
utilized to execute any LabTalk script prior to computation of the main column formula. The 
Variables menu provides a flexible interface in which to insert LabTalk script commands to 
access columns and other metadata contained in any sheet or book in the Origin Project. 
 

 

 

 

Various properties of the workbook can be customized using the Worksheet Properties 
dialog, which can be accessed from the Format menu. Worksheet cells can contain links to 
cells in other worksheets or report sheets, and can also contain embedded graphs, images 
from external disk files, or images corresponding to matrix objects contained in the Origin 
Project. Groups of cells in a worksheet can be merged, allowing for objects such as embedded 
graphs to be displayed over a larger area. These features, when combined, allow for the 
worksheet to be utilized as a flexible document for creating custom reports combining graphs, 
images, and analysis results. Such custom reports can then be exported as image files, such 
as PDF or JPEG, and can also be used for presenting results as part of an Analysis 
Templates. 
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The workbook can contain additional metadata such as properties of data files imported into 
the worksheet, including variables extracted from header lines contained in the data file. Such 
metadata can be viewed in the Workbook Organizer panel, which can be accessed through 
the context menu that opens when you right-click on the worksheet window title. The metadata 
is then available for access in dialogs such as the Set Values dialog for setting column values. 



 2.2 Hierarchy of Origin Objects 

12 Introduction to Origin 

 

 
 
 

Matrix Books 

The Matrix Book in Origin is a collection of Matrix Sheets or Layers. Each matrix sheet can in 
turn contain multiple Matrix Objects. Each matrix object is a two-dimensional array of 
numbers. The data types supported include floating point, integer and complex. 
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Matrix objects in a matrix sheet can also be viewed as image thumbnails. With the matrix sheet 
active, select View: Show Image Thumbnails from Origin's main menu, or from the right-click 
context menu of the matrix window title bar. 
 

 
 

Each matrix object has associated X and Y coordinates. You can assign arbitrary begin and 
end values for X and Y coordinates, and those values will be used to create a linear map of 
coordinate values in X and Y. The coordinate values are used by Origin to set the axes when 
creating plots such as 3D Surface or Contour plots from the matrix data, and also by analysis 
operations such as surface fitting. 

The matrix dimensions, coordinates and X/Y/Z Labels, including Long Name, Units and 
Comments, can be customized using the Matrix Dimension and Labels dialog. The matrix 
data type, display, and Z Labels can be controlled using the Matrix Properties dialog. Both 
dialogs can be accessed from the Matrix menu. All matrix objects contained in a given matrix 
sheet share the same dimensions properties (number of cells, and X/Y coordinates) and X/Y 
Labels, although each can have different settings for properties such as data type, display and 
Z Labels. 
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The Set Values dialog, which can also be accessed from the Matrix menu, allows you to 
specify a formula for generating the numbers in a matrix. 
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When a matrix contains numeric data, the top right corner of the window displays a D icon. A 
matrix object can also contain an image, such as an image imported from a disk file, instead of 
numeric data. When a matrix object contains an image, the top right corner displays an I icon. 
Basic image processing tools in Origin can operate on images stored in matrix objects. Images 
can be converted to numeric data and vice versa using menu items under the Image menu. 

As mentioned earlier, all matrix objects in a matrix sheet can be viewed as thumbnail images. 
The bottom panel of the matrix window can display only one matrix object from one matrix 
sheet at a given time. The display can be toggled between Data Mode and Image Mode, using 
the View menu. In Data Mode the display can also be toggled to either show the X and Y 
index or the actual X and Y coordinates, using the View menu. 
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Virtual Matrix 

Data arranged in a group of worksheet cells can be treated as a virtual matrix, and such data 
can be used to create 3D plots, such as color mapped surfaces or contour plots. The X and Y 
coordinate values can be contained in data rows/columns or label rows of the worksheet. 
Nonlinear spacing of X and Y values is supported for a virtual matrix. 
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Graph 

An Origin Graph Page can contain multiple Graph Layers, where each layer is comprised of a 
set of axes. Each graph layer can in turn contain multiple Data Plots. A Data Plot is simply a 
plot of one data set. 

Graph layers can be separate from each other or can physically overlap in the graph page. The 
axes in one layer can also be linked to axes of other layers. This hierarchy provides a very 
flexible way to present multiple data plots in one graph in multiple layers, at the same time 
maintaining desired relationships between the data plots. 
 

 
 
 
 

The Plot Details dialog, which can be accessed from the Format menu or by double-clicking 
on a data plot, provides a hierarchical interface for setting properties of the graph, such as: 

• Page level - Page dimensions, colors, legend, etc. 

• Layer level - Layer dimensions, linking, colors. etc. 

• Data plot level - Specific formatting for each plot style. 



 2.2 Hierarchy of Origin Objects 

18 Introduction to Origin 

 

 

 

Double-clicking on any axis of a layer opens the Axis Dialog, which can be used to set 
properties of the axes such as tick directions, grid lines, and display format of tick labels. 
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The Layer Contents dialog can be accessed by double-clicking or right-clicking on the layer 
icons displayed on the top left of the graph page. The left panel of the dialog can be used to 
filter and list available datasets, such as datasets in current worksheet, or entire project. Data 
can be selected and easily added to, or removed from, the right side panel which represents 
the layer contents. Controls in the right side panel provide options such as grouping and re-
ordering the data plots in the layer. Note that the dialog works on only one layer at a time. If 
you wish to switch to another layer in your graph, you need to close the dialog and re-open it 
from the layer icon corresponding to the desired layer. 
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The Plot Setup dialog, which can be accessed by right-clicking on the layer icon and selecting 
Plot Setup, provides a flexible interface for adding or removing data plots from any layer in 
your graph, reordering data plots, and other operations such as grouping or un-grouping plots 
in a layer. This dialog also opens when the user selects a particular graph template without 
pre-selecting data columns. In this mode the dialog becomes the primary tool for creating new 
plots using an existing template, and it offers the flexibility of selecting multiple data sheets in 
the project. This dialog also allows flexible assignment of data columns, such as the ability to 
select which column to use for X and which column to use for Y, in the case of a 2D plot. 
 

 
 
 

2.3 Operations and Recalculation 

Starting with version 8, results of various operations in Origin can be updated when source 
data is changed, or when a user decides to recall and change parameters of the operation. 
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This feature is referred to as Recalculation. Dialogs for various operations such as setting 
values of columns based on other columns, extracting worksheet data using conditions on the 
data, and nonlinear curve fitting of data, all provide control for users to specify whether the 
Recalculate feature should be turned on. Furthermore, users can decide whether the output 
should update automatically (Auto), or update should occur only when manually triggered 
(Manual). 

If Recalculate is set to Auto or Manual, Origin saves all pertinent information related to the 
operation. For instance, if Recalculate is set in the Set Values dialog for setting column 
values, information about the source column(s), the formula, and any Before-Formula script are 
saved. If the operation is related to curve fitting, the details of the operation including source 
data, what reports have been generated, and all settings relevant to the fitting operation are 
saved. 

Operations that have Recalculate enabled are marked by displaying a lock on all output 
objects such as worksheet columns and graph layers related to the operation. The lock icons 
appear as in the picture below: 
 

Recalculate Auto Recalculate Manual Recalculate Manual—Needs Updating 

   

 

A green lock means that output is up to date based on the current data. A yellow lock means 
that the output is based on previous data, and needs updating. Various options for managing 
the operation are available via the context menu displayed when clicking on the lock. For 
example, the user can click on the lock and select Change Parameters, which will then display 
the dialog associated with the operation, loaded with the exact settings used at the time the 
operation last executed. Users can change the settings and close the dialog to update the 
output. 

The lock icon is object-specific— each worksheet column or graph layer associated with the 
operation will have its own lock indicating whether the data has been updated or needs 
updating. There is also a project-level indicator for recalculation on the Standard Toolbar:  
 

All Outputs Updated Outputs Need Updating 

  

 

If one or more outputs in the current project need recalculation, this icon will become yellow. 
Pressing this button will update all operations for which input data has changed. This button is 
grayed out if recalculation is not active anywhere within the project. 
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2.4 Themes and Templates 

The hierarchy of Origin objects such as graph pages, combined with extensive object 
properties, lends itself to the creation of custom settings for repeat use. You can save your 
custom settings either as templates or themes, described briefly in the following sections. For 
detailed information please refer to Origin Help. 

Templates 

Customizations performed on objects such as graph pages or worksheets can be saved as 
templates for repeat use. For example, you can customize a graph page to add multiple layers, 
set relationships between layers, modify data plot properties, and then save all of these 
attributes as a graph template (.OTP) file. 

Origin ships with over 100 built-in graph templates. You may customize and re-save these 
templates, or create new templates as desired. 

To create a new template from a customized graph, click File in the Main Menu, and then click 
Save Template As< To access this template after saving, click Plot, and then click Template 
Library.  
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Origin also extends the template concept to workbooks, matrix books, and analysis templates. 

You can save workbook or matrix book settings, such as font, color, display format, custom 
header rows, or dimension and coordinate settings, to .OTW (workbook template) or .OTM 
(matrix template) files. 

Save data operations, even complex operations such as curve fitting with custom report 
sheets, to an analysis template (.OGW or .OPJ) for repeat analysis of similar data. Analysis 
templates are explained in more detail in a later section. 

Themes 

An Origin theme is a file containing a set of object properties. These properties could be as 
simple as axis tick mark direction settings, or as extensive as a collection of multiple graph 
object properties. 

Themes provide the ability to quickly change an object, such as the look of a graph. For 
example, you may apply a black-and-white theme to a color graph in order to prepare it for 
publication. 

With themes, you can apply object properties from one graph to other graphs in the same 
project. 
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Right-click in a graph window, point to Copy Format, and then select one of the options from 
the menu such as Colors, Fonts, All Style Formats, or All. Right-click another graph and 
click Paste Format to apply the copied settings to the target graph. This procedure can be 
applied to single elements, such as copying only the settings of a scatter plot from one graph to 
another.  

 

 

 

The Theme Organizer dialog is available in the Tools menu. Use this dialog to organize and 
apply themes to graphs and worksheets. With this dialog you can apply a graph theme to 
multiple graphs in the Origin project. 

To combine multiple themes in the Theme Organizer dialog, hold down Ctrl while selecting the 
themes, and then right-click to access the Combine context menu. The context menu in the 
tool provides an option to edit a theme, allowing the user to add/delete properties to an existing 
theme. 
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The theme concept extends to dialog settings as well. You can customize settings of dialogs, 
such as the Smoothing dialog (available in the Signal Processing menu under Analysis), 
and then save the settings to disk as a named theme file. You can save multiple theme files for 
each dialog and then recall them from the dialog. In this way, dialogs can be customized for 
different purposes such as processing data from different experiments with specific settings. 
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2.5 Sharing Origin Files 

You may want to customize your Origin installation for your specific needs and then share your 
customizations with other Origin users. Custom settings can be saved in many file types 
including graph templates (.OTP) and themes (.OTH), analysis templates (.OGW or .OPJ), 
dialog themes, curve fitting functions, import wizard filters, LabTalk script files (.OGS), and X-
Functions. 

For a complete list of Origin file types please see Origin Help. 

Drag and Drop Sharing 

A quick and easy way to share a file with another user is simply to send it as an email 
attachment. The recipient can then drag and drop the file into the Origin workspace. 
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Drag-and-drop is supported for most Origin file types. Origin project (.OPJ) and graph template 
(.OTP) files automatically open when dropped into the workspace. Other files are copied to the 
appropriate subfolders in the User Files Folder. For example, when you drop a fitting function 
(.FDF) file into the workspace, a dialog opens asking for the name of the fitting function 
category to which the new function should be added. 

Sharing Files with Multiple Machines for Single Users 

If you are a single user and have installed Origin on multiple machines, you can share your 
custom settings across multiple installations. Set up the User Files Folder (UFF) on a shared 
location, such as a network drive, or even a USB flash drive, and use the same UFF path with 
each installation. 

Please see Origin Help for information on changing the UFF path. 

Sharing Files with Other Users in a Network 

You can set up and use a group folder to share files among users. Multiple groups are allowed, 
and each group can have a specific user set as the group manager. The group manager can 
use the Group Folder Manager tool to publish custom files for sharing with other group 
members. 

Please see Origin Help for more information. 

Packaging Files 

Origin provides a Package Manager tool for packaging multiple files into a single Origin 
Package (.OPX) file. This is a convenient way to distribute custom applications that may 
contain multiple Origin files, such as templates, X-functions, and LabTalk script files. The 
Package Manager includes options for running LabTalk scripts before and after installation. 

To access the Package Manager, click Tools, and then click Package Manager< 

To install an .OPX file, simply drag and drop into the Origin workspace. 

For more information, please see Origin help. 
 

2.6 Analysis Templates and Batch Processing 

After performing an operation (such as Set Column Values or Nonlinear Curve Fitting), you can 
save your workbook as an analysis template. Set Recalculation to Auto or Manual, and then 
click Save Workbook as Analysis Template< Origin will clear all input and output data 
related to the operation and save the workbook as an analysis template (.OGW) file. 

To reuse this template, click File in the main menu, and then click Recent Books. Select your 
analysis template from the list of recent workbooks to open. You can then import new data into 
the appropriate source columns, and the output columns and sheets will update automatically if 
Recalculation was set to Auto, or you can update them manually if Recalculation was set to 
Manual. 
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An analysis template workbook (.OGW) can contain multiple related operations. For example, 
one operation might extract data from the raw data sheet using conditions specified in the 
Extract Worksheet Data tool, and the next operation might be a nonlinear fitting on the 
extracted data. In this example, when new data is added to the raw data sheet, the Extract 
Worksheet operation triggers first. The updated output from this operation then triggers the 
second operation - the curve fitting. Analysis templates thus provide an easy way to create 
custom analysis routines, and then reuse them for analysis of similar data. 

You can also save an entire Origin project (.OPJ) as an analysis template. This can be useful 
when your analysis requires more than one workbook, or requires both workbooks and matrix 
books. To save your Origin project as an analysis template, click File, and then click Save 
Project as Analysis Template. 

Origin provides a tool for performing batch processing of multiple datasets using an analysis 
template. You can access this tool by clicking File, and then Batch Processing. 

The Batch Processing tool can process multiple data files on the disk, or it can process data 
already in the project, such as multiple Y columns in a worksheet, or multiple XY data curves in 
multiple sheets or books. 

When you create an analysis template, you have the option to add a summary sheet. You can 
copy output quantities such as parameter values from fitting results, and paste-link them into 
the summary sheet. The Batch Processing tool can collect the information from the summary 
sheet, and append it to a report sheet for each dataset. The information in the report sheet can 
then be further processed or plotted. 
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Origin provides tutorials which demonstrate how to create and save analysis templates, and 
then use them to perform batch processing of multiple data files or data sets. To access these 
tutorials, click Origin’s Help menu, and then click Tutorials. 
 

2.7 OriginPro 

OriginPro, the professional version of Origin, provides all of the features of Origin, plus 
additional analysis tools and capabilities. These include features in the areas of Peak 
Analysis, Statistics, Signal Processing, Image Processing, and 3D Surface Fitting. 
Please refer to the Products area of the OriginLab website (www.originlab.com) for more 
information on OriginPro. 

If you have already purchased the standard version of Origin, you can upgrade to OriginPro by 
contacting your Origin representative. 
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2.8 Programming in Origin 

Origin provides two programming languages: 

• LabTalk 

• Origin C 

LabTalk is a scripting language that provides access to most of Origin’s functionality. With 
LabTalk you can access and change properties of such Origin objects as worksheet columns, 
graph layers, and data plots. You can also use LabTalk to access X-Functions to perform tasks 
such as data importing, data analysis, graph and worksheet exporting, and batch processing. 

Origin C is a full-featured high-level programming language based on the ANSI C 
programming language syntax. In addition, Origin C supports a number of C++ features and a 
few C# features. Origin C provides access to all aspects of Origin, including data import, data 
handling, graphing, analysis, and exporting. You can access Origin C functions from user 
interface controls such as buttons, toolbars, and menu items, or by creating X-Function-based 
dialogs. 

Origin ships with a printed LabTalk Scripting Guide and an Origin C Programming Guide. They 
provide an overview of scripting and Origin C programming, along with numerous examples for 
all key areas and operations. These guides are also available in Origin’s Help menu. In 
addition, you can access detailed language reference help files for LabTalk and Origin C from 
the Help menu. 

The OriginLab wiki site (wiki.originlab.com) contains the most up-to-date documentation for 
LabTalk and Origin C. 

The choice of which language to use for programming in Origin is mainly a question of 
complexity of the task. LabTalk is well-suited for simple operations, such as importing and 
manipulating data in worksheet columns, or for performing analysis tasks such as smoothing, 
interpolation, or curve fitting. In fact, the Set Column Values dialog uses LabTalk script when 
performing column transformations. 

LabTalk scripts can be easily executed from the Command and Script windows, or from 
toolbar buttons and menu items. Multiple lines of scripts can be saved to a file, optionally 
organized in sections, and called for execution from the interface. LabTalk scripts can include 
calls to X-Functions that perform advanced data processing and analysis. 

In short, if you are beginning to explore programming in Origin, LabTalk is a good place to 
start. As your Origin programming needs grow, or if you require advanced customization 
involving extensive coding, it is recommended that you switch to the Origin C programming 
environment. 

Origin C provides access to all Origin objects and properties. Origin C is organized as a set of 
functions with support for passing arguments. Origin C functions are compiled to object code 
and then loaded and executed inside of Origin. Origin C provides increased reliability and 
manageability for developing and debugging code with greater scope and complexity. 
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Origin C is the language used to create X-Functions. An X-Function is a self-included XML file 
that can be loaded in Origin as a special type of global function. X-Functions provide a way to 
expand the functionality of Origin by adding custom data processing features. You can also 
create custom tools and dialogs with Origin’s Developer Kit to build dialog resources, and 
then use Origin C to access such dialogs within Origin. 

In addition to the two programming languages, Origin can also be accessed as an Automation 
Server. Client applications such as National Instruments LabVIEW, Microsoft Excel, or custom 
VB/VC/C# applications can exchange data with Origin, and can also send commands to be 
executed within Origin. 
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3 Origin Resources 

The following sections summarize key Origin resources available to you. If you purchased 
Origin from a local distributor, your Origin distributor may provide additional resources. Please 
contact your distributor to learn more. 

3.1 Help Files 

Help files for various features in Origin, including programming, can be accessed from the 
Origin Help menu. Help files are typically updated at every service release. To check for 
availability of updated help files, click Help, and then click Check for Updates. 

The most up-to-date versions of our Help files are available in the Support area of the 
OriginLab website (www.OriginLab.com) and at the OriginLab wiki site (wiki.OriginLab.com). 

3.2 Tutorials 

Tutorials are accessible from the Help menu in the product. Video Tutorials are available from 
the Support area of OriginLab’s website. These videos offer an easy way to become familiar 
with many of Origin’s key features. OriginLab frequently adds new videos, so be sure to check 
back regularly. 

3.3 User Forum 

The OriginLab user forum is very active with Origin users asking and answering questions, and 
sharing tips on using Origin. The forums are monitored by Origin technical staff on a regular 
basis. 

Access the Origin User Forum from the home page of OriginLab’s website. 

3.4 Case Studies 

The OriginLab website provides a collection of case studies, exploring how Origin users in 
various fields are using key features for their data analysis and graphing needs. We 
recommend that you view the case study collection for ideas and suggestions about using 
Origin for your field of work. 
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3.5 Graph Gallery 

The Graph Gallery presents a large collection of graphs, accessible from the home page of 
the OriginLab website. The graphs illustrate the wide variety of graph templates and advanced 
customization options available in Origin. 

3.6 Wiki Site 

The OriginLab wiki site hosts the most up-to-date version of our programming documentation. 
The wiki site also offers release notes with detailed information on features added in each 
version and service release, as well as information regarding other areas, such as installation 
and licensing of the product, and notes for upgrade users. 

3.7 Software Updates 

OriginLab publishes periodic software updates, called Service Releases, for the current version 
of Origin. In Origin’s Help menu, click Check for Updates to quickly and easily check whether 
a new service release is available. The Release Notes section of our wiki site provides 
pertinent information about what features and fixes are available in the current service release. 

3.8 Technical Support 

OriginLab and our team of international Origin distributors are committed to providing timely 
and helpful Origin support. If you purchased Origin from a local distributor, please contact your 
distributor for support. Otherwise, contact Originlab for support. Contact information for both 
OriginLab and the Origin distributor team is available in the Support area of the OriginLab 
website. To access these pages from within Origin, click Help, then point to Support, and then 
click Contact OriginLab Support or Contact your Distributor. 

If you have a suggestion for adding or improving a feature in Origin, or if you have found a bug, 
we want to hear from you. To report a bug or request a feature, click Help, then point to 
Support, and then click Submit a Feature Suggestion or Submit a Bug Report. You can 
also notify us from the Support area of the OriginLab website. 

3.9 Training and Consulting 

OriginLab provides training and consulting services to help customers make optimal use of our 
products. To learn more about these services, see the Support area of the OriginLab website. 
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4 Origin Toolbars 

Presented below is a list of all toolbars and buttons in Origin. Certain toolbar buttons (or entire 
toolbars) will be inactive (grayed out) if the object they act on is not present in the Origin 
Project. For instance, the 3D-Rotation Toolbar is only available when a 3D graph is active. 

4.1 Standard 

 
 

Button Description Button Description 

 
New Project 

 
New Folder 

 
New Workbook 

 
New Excel Workbook 

 
New Graph 

 
New Matrix 

 
New Function 

 
New Layout 

 
New Notes 

 
Digitize Image 

 
Open 

 
Open Template 

 
Open Excel 

 
Save Project 

 
Save Template 

 
Import Wizard 

 
Import Single ASCII 

 
Import Multiple ASCII 

 
Batch Processing 

 
Recalculate Manual 

 
Recalculate Auto 

 
Zoom In and Out by Percentage 

 
Print 

 
Slide Show of Graphs 

 
Send Graphs to PowerPoint 

 
Refresh 



 4.2 Edit 
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Duplicate 

 
Custom Routine 

 
Project Explorer 

 
Results Log 

 
Command Window 

 
Code Builder 

 
Add New Columns   

4.2 Edit 

 
 

Button Description Button Description 

 
Cut 

 
Copy 

 
Paste 

 
Undo 

4.3 Graph 

 
 

Button Description Button Description 

 
Zoom In 

 
Zoom Out 

 
Whole Page 

 
Rescale 

 
Extract to Layers 

 
Extract to Graphs 

 
Merge 

 
Add Bottom-X Left-Y Layer 

 
Add Top-X Layer 

 
Add Right-Y Layer 

 
Add Top-X Right-Y Layer 

 
Add Inset Graph 

 
Add Inset Graph With Data 

 
Add Color Scale 



 4.4 2D Graph 

 Origin Toolbars 37 

 
New Legend 

 
Add XY Scale 

 
Date & Time 

 
New Link Table 

4.4 2D Graph 

 
 

Button Description Button Description 

 
Line 

 
Horizontal Step 

 
Vertical Step 

 
Spline Connected 

 
Scatter 

 
Scatter Center 

 
Y Error 

 
X Y Error 

 
Vertical Drop Line 

 
Bubble 

 
Color Mapped 

 
Bubble + Color Mapped 

 
Line + Symbol 

 
Line Series 

 
2 Point Segment 

 
3 Point Segment 

 
Column 

 
Column + Label 

 
Bar 

 
Stack Column 

 
Stack Bar 

 
Floating Column 

 
Floating Bar 

 
3D Color Pie Chart 

 
2D B&W Pie Chart 

 
Double Y Axis 

 
3Ys Y-YY 

 
3Ys Y-Y-Y 

 
4Ys Y-YYY 

 
4Ys YY-YY 

 
Multiple Y Axes 

 
Stack Lines By Y Offsets 
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Waterfall 

 
Waterfall Y: Color Mapping 

 
Waterfall Z: Color Mapping 

 
Vertical 2 Panel 

 
Horizontal 2 Panel 

 
4 Panel 

 
9 Panel 

 
Stack 

 
Multiple Panels by Label 

 
Box Chart 

 
Histogram 

 
Histogram + Probabilities 

 
Stacked Histograms 

 
QC(X-bar R) Chart 

 
Pareto Chart-Binned Data 

 
Pareto Chart-Raw Data 

 
Scatter Matrix 

 
Probability Plot 

 
Q-Q Plot 

 
Area 

 
Stack Area 

 
Fill Area 

 
Polar theta(X) r(Y) 

 
Polar r(X) theta(Y) 

 
Wind Rose-Binned Data 

 
Wind Rose-Raw Data 

 
Ternary 

 
Smith Chart 

 
High-Low-Close 

 
Radar 

 
Vector XYAM 

 
Vector XYXY 

 
Zoom 

 
Japanese Candlestick 

 
OHLC Bar Chart 

 
OHLC-Volume 

 
Template Library   
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4.5 3D and Contour Graph 

 
 

Button Description Button Description 

 
3D Scatter Plot 

 
3D Trajectory 

 
3D Error Bar 

 
3D Vector XYZ XYZ 

 
3D Vector XYZ dXdYdZ 

 
XYY 3D Bars 

 
3D Ribbons 

 
3D Walls 

 
3D Color Fill Surface 

 
3D X Constant with Base 

 
3D Y Constant with Base 

 
3D Color Map Surface 

 
3D Color Fill Surface with Error Bar 

 
3D Color Map Surface with Error Bar 

 
Multiple Color Fill Surfaces 

 
Multiple Color Map Surfaces 

 
3D Wire Frame 

 
3D Wire Surface 

 
Matrix 3D Bars 

 
Matrix 3D Scatter 

 
Matrix 3D Error Bar 

 
Contour - Color fill 

 
Contour - B/W Lines + Labels 

 
Gray Scale Map 

 
Contour Profiles 

 
Polar Contour theta(X) r(Y) 

 
Polar Contour r(X) theta(Y) 

 
Ternary Contour 

 
Image Plot 

 
Image Profiles 
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4.6 3D Rotation 

 
 

Button Description Button Description 

 
Rotate counterclockwise 

 
Rotate clockwise 

 
Tilt left 

 
Tilt right 

 
Tilt down 

 
Tilt up 

 
Increase perspective 

 
Decrease perspective 

 
Fit frame to layer 

 
Reset rotation 

 
Rotation Angle   

4.7 Worksheet Data 

 
 

Button Description Button Description 

 
Statistics on Column(s) 

 
Statistics on Row(s) 

 
Sort   

Set Column Values 

 
One column 

 
All columns 

 
Row number 

 
Uniform random numbers 

 
Normal random numbers   
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4.8 Column 

 
 

Button Description Button Description 

 
Set as X 

 
Set as Y 

 
Set as Z 

 
Set as Y Error Bars 

 
Set as Labels 

 
Set as Disregard 

 
Set as Grouping 

 
Set as Subject 

 
Move to First 

 
Move Left 

 
Move Right 

 
Move to Last 

 
Swap Columns   

4.9 Layout 

 
 

Button Description Button Description 

 
Add Graph 

 
Add Worksheet 
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4.10 Mask 

 
 

Button Description Button Description 

 
Mask Range 

 
Unmask Range 

 
Change mask color 

 
Hide/Show masked points 

 
Swap mask 

 
Disable/Enables masking 

4.11 Tools 

 
 

Button Description Button Description 

 
Pointer 

 
Scale In 

 
Scale Out 

 
Screen Reader 

 
Reader 

 
Annotation 

 
Cursor 

 
Data Selector 

 
Selection on Active Plot 

 
Selection on All Plots 

 
Mask Points on Active Plot 

 
Mask Points on All Plots 

 
Unmask Points on Active Plot 

 
Unmask Points on All Plots 

 
Draw Data 

 
Text Tool 

 
Arrow Tool 

 
Curved Arrow Tool 
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Line Tool 

 
Polyline Tool 

 
Freehand Draw Tool 

 
Rectangle Tool 

 
Circle Tool 

 
Polygon Tool 

 
Region Tool 

 
Panning 

 
Insert Equation 

 
Insert Word Object 

 
Insert Excel Object 

 
Insert Object 

 
Rescale Tool   

4.12 Object Edit 

 
 

Button Description Button Description 

 
Left 

 
Right 

 
Top 

 
Bottom 

 
Vertical 

 
Horizontal 

 
Uniform Width 

 
Uniform Height 

 
Front 

 
Back 

 
Front(data) 

 
Back(data) 

 
Group 

 
Ungroup 
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4.13 Arrow 

 
 

Button Description Button Description 

 
Horizontal Alignment 

 
Vertical Alignment 

 
Widen Head 

 
Narrow Head 

 
Lengthen Head 

 
Shorten Head 

4.14 Style 

 
 

Button Description Button Description 

 
Fill Color 

 
Line/Border Color 

 
Palette 

 
Line/Border Style 

 
Line/Border Width 

 
Fill Pattern 

 
Fill Pattern Width 

 
Pattern Color 

 
Clear Borders 

 
Left Border 

 
Top Border 

 
Right Border 

 
Bottom Border 

 
Frame Borders 

 
Inside Horizontal Borders 

 
Inside Vertical Border 

 
Inside Horiz and Vert Borders 

 
All Horizontal Borders 

 
All Vertical Borders 

 
All Borders 
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Merge cells   

4.15 Format 

 
 

Button Description Button Description 

 
Font 

 
Font size 

 
Bold (Ctrl+"B") 

 
Italic (Ctrl+"I") 

 
Underline (Ctrl+"U") 

 
Superscript (Ctrl+"+") 

 
Subscript (Ctrl+"=") 

 
SuperSubscript (Ctrl+"-") 

 
Greek (Ctrl+"G") 

 
Increase Font (Ctrl+">") 

 
Decrease Font (Ctrl+"<") 

 
Left 

 
Center Horizontal 

 
Right 

 
Top 

 
Center Vertical 

 
Bottom 

 
Font Color 

4.16 Auto Update 

 
 

Button Description 

 
Auto Update On 
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4.17 Database 

 
 

Button Description Button Description 

 
Open SQL Editor 

 
Open Query Builder 

 
Load ODQ File 

 
Preview Import 

 
Import data 

 
Remove SQL 

4.18 Markers & Locks 

 
 

Button Description Button Description 

 
Add Data Markers 

 
Clear Data Markers 

 
Marker Size 

 
Marker Hide Show 

 
Lock Positions   

 
 
 


